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Tables are the perfect solution for creating documents 
where you want to present information in a grid structure. 
For example, you could use tables to create order forms, 
invoices, price lists, and much more.  

In this booklet you will: 

 gain an understanding of tables and how to insert 
and format them 

 learn how to create a table 

 learn how to add data to a table 

 learn how to select table components using the 
ribbon 

 learn how to select text and cells in a table using 
the mouse 

 learn how to insert columns and rows 

 learn how to delete columns and rows from a 
table 

 learn how to change column widths 

 learn how to change row heights 

 learn how to use the column autofitting feature 

 learn how to apply shading to cells 

 learn how to modify table borders 

 learn how to modify border styles 

 learn how to apply a table style to a table 

INFOCUS 



Microsoft Word 2010 - Level 1 

© Learning and Development Service Page 3 Tables 

UNDERSTANDING TABLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A table lets you present information in a 
grid-like format. Consider a roster – it may 
show the days of the week across the top 
of the table, one day per column; list the 

employees down the left side of the table, 

one person per row; and show who is 
rostered on each day by the number of 
rostered hours in the cell beneath the 
relevant day.   

What is a Table? 

A table comprises one or more horizontal rows and one or 
more vertical columns. The rectangle where a row and 
column intersects is called a cell.  Each cell can be filled 
with text, pictures or other objects. 

Inserting Tables 

Depending upon the type and style of table you require, there are several ways in 
which you can insert tables into a document. Access to each of these functions is via 
the Table tool  which is found on the Insert tab on the ribbon. 

This table had a table style 
applied to it. It then had 
various other formatting 

applied, including borders, 
header cells, cell merging, and 
font size. 

Formatting Tables 

After inserting a table into your document, Word offers you many ways in which you 
can format it.  

If you want to change the look of the entire table, you can use Table Styles. The 
advantage of using Table Styles is that as you hover over the various styles included 
in the gallery, Word automatically changes the appearance of your table so you can see 
how it will appear if you select the style. 

You can also format many other aspects of your table using the various tools on the 
Table Tools Design and Layout tabs. For example, you can apply shading and 
borders; specify headers and total rows; split and merge cells; insert and delete rows, 
columns and cells; alter the alignment within the cells; plus much, much more. 

If you want to quickly insert a formatted table into 
your document, you can choose from one of Microsoft 
Word’s Quick Tables, such as the example on the 
right. Quick Tables are tables that are preformatted 
with shading, column and row layout, and so on. They 
also contain sample information which you can use to 
help visualise the way your data will appear. After 
inserting a quick table, you can then replace the 
sample data with your own. You can also modify the 
table − such as deleting or inserting rows or columns 

− just like any other table.  

If you want to add a simple, unformatted table, you 
can drag to select the number of rows and columns 
that you require on the Insert Table grid. 
Alternatively, you can also insert a simple table, 
specifying the desired number of rows and columns, 
using the Insert Table dialog box. This method also 

lets you specify additional settings such as fixed 
column width and autofit. 

If you want to add a more complex table − for 
example, you may require a varying number of 
columns per row − you can quickly draw a table like 
the example on the right. 
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CREATING A TABLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 

the file W819 Creating 
Tables_1.docx... 

1 Press  +  to move 

to the end of the 
document 

2 Click on the Insert tab 
on the ribbon 

3 Click on Table  in 

the Tables group to 
open the Insert Table 
grid and drop-down 
menu 

4 Select Insert Table to 
open the Insert Table 
dialog box 

5 Type 3 in Number of 
columns 

6 Press  to jump to 

Number of rows and  
type 5 

The Insert Table dialog 
box also gives you the 
opportunity to specify 
column width and to set 
your choices as the 
default values for future 
tables... 

7 Click on [OK] to create 
the table in your 
document 

 

For Your Reference… 

To create a simple table: 
1. Click on Table  in the Tables group 

2. Select Insert Table 
3. Type the Number of columns and 

rows, and specify other options as 
desired 

4. Click on [OK] 

Handy to Know… 

 You can also insert a plain, 
unformatted table using the Insert 
Table grid. To do this, click on Table 

 in the Tables group, then point to 

the square representing the number of 
columns and rows that you need for 
your table (e.g. 5x4 Table). Click on 

the square to insert the table.  

One of the simplest ways of creating a 
plain, unformatted table is by using the 
Insert Table command. This command 
opens the Insert Table dialog box from 

which you can specify the number of 

columns and rows that you require as well as 
the column width. When you use this 
command, Word will create a table with 
equally spaced columns and rows based on 

your settings. 

4 

7 

3 
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ADDING DATA TO A TABLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W819 Creating 
Tables_2.docx... 

1 Click in the top left 
cell of the table to 
ensure the insertion 
point is located at the 
start of the table 

2 Type Catalogue No, 
then press  to 

jump to the next 
column 

3 Type Model, then 
press  to jump to 

the next column 

4 Type Country, then 
press  to jump to 

the first column in the 
second row 

5 Repeat the above 
steps to complete the 
table as shown 

If you press  when 

you get to the end of 
the last row in the 
table, Word will 
automatically create a 
new row for you 

 

For Your Reference… 

To enter data into a table: 
1. Click in a table cell and type 

2. Press  to jump to the next cell 

Handy to Know… 

 If you want to indent or align text 
within a cell, press  +  to move 

the insertion point to the next tab stop. 
If you press  the insertion point will 

move to the next cell. 

4 

There’s no real rocket science here – to 
enter text or data into a table you simply 
click in the cell and type. The text you 
enter into a table follows virtually the same 

rules as for the text that you type into 

another part of the document. The text is 
based on a style. It can be formatted in the 
same way as normal text. It can also be 
aligned in the same way as a normal 

paragraph. 

1 

5 
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SELECTING IN TABLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To select in tables using the ribbon: 
1. Click in the cell, then click on Select 

 

2. Click on Select Cell to select the cell, 
or  

Click on Select Column to select the 
column, or 

Click on Select Row to select the row 

Handy to Know… 

 You can also select table components 
using the keyboard. For example, to 
select a cell position the cursor 
anywhere in a cell and press  +  

+ . 

4 

After inserting a table and entering 
content, the next thing you’ll want to do is 
to format the table. But before you can do 
this, you must first learn how to select the 

various table components. If you want to 

select standard components, such as a cell, 
column, row, or the entire table, you can 
quickly select these using the Select tool, 
which is found on the Layout tab on the 

ribbon. 

3 

5 

6 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W819 Creating 
Tables_3.docx... 

1 Click anywhere on Italy 
in the table – this is the 
active cell 

Notice that two additional 

Table Tools tabs have 
appeared in the ribbon: 
Design and Layout... 

2 Click on the Table Tools: 
Layout tab on the ribbon 

3 Click on Select  in the 

Table group, then click 

on Select Cell to select 
the active cell 

4 Click on Select  in the 

Table group, then click 
on Select Column to 
select the column 
containing the active cell 

5 Click on Italy again, click 
on Select  in the 

Table group, then click 
on Select Row to select 
the row containing the 
active cell 

6 Click on Select  in the 

Table group, then click 
on Select Table to select 
the entire table 
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SELECTING USING THE MOUSE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To select in tables using the mouse: 

 Click just outside the table to the left 
of a row to select the row 

 Click just outside the table above a 
column to select the column  

 Click on the table move handle  

to select the entire table 

Handy to Know… 

 You can select text in a cell by double-
clicking on the first word and then 
dragging to the end of the cell. 

 To select a single cell, hover over the 
left border of the cell until the pointer 
appears as a small black right-pointing 
arrow , then click. 

2 

3 

You can only select standard table 
components using the ribbon. But, using 
the mouse, you can select all aspects of a 
table. For example, you can select text in a 

single cell, or in a contiguous or non-

contiguous range of cells. You can also select 
a single cell, as well as a contiguous and 
non-contiguous range of cells, rows and 
columns. And, of course, you can select the 

entire table. 

5 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or open 

the file W819 Creating 
Tables_3.docx... 

1 Click on the word Electric, 
then drag to the right end of 
the cell to select both words 

2 Click anywhere in TEL00001, 
then drag down to 
COM00014 to select the text 
in the range of cells 

3 Double-click on Model, hold 
down , then double-click 

on both 1660 and Italy to 
select text in a non-
contiguous range 

4 Hover outside the table to the 
left of TEL00015 – the 
pointer will change to a white 

right-pointing arrow  − click 
then drag down to the next 
row to select both rows  

Hold down  and click to 

select non-contiguous rows... 

5 Hover just above the top of 
the Model column – the 
pointer will change to a black 
downwards-pointing arrow , 
then click to select the 
column 

6 Hover anywhere over the 
table – the table move 
handle  will appear – then 
click on it to select the entire 
table 
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INSERTING COLUMNS AND ROWS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To insert a new column or row: 
1. Click on the desired table cell, then 

activate the Table tools: Layout tab 
2. From the Rows & Columns group, 

click on Insert Left or Insert Right to 

insert a new column, or click on Insert 
Above or Insert Below to insert a 

new row 

Handy to Know… 

 An alternative method for inserting a 
column is to split an existing column into 
two (or more). To do this, select the 
entire column, then click on Split Cells  

in the Merge group to open the Split 
Cells dialog box. If you want to keep the 
entries in the selected cells, deselect 

Merge cells before split. 

2 

4 

In an ideal world you would have correctly 
determined the numbers of rows and 
columns required before you created your 
table. But in the real world, you will often 

find that you underestimate the number of 

columns and/or rows that you really need. 
Fortunately, Word makes it easy to insert 
new rows and columns into your table. 

6 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W819 Creating 
Tables_3.docx... 

1 Click on Country, then 
ensure that the Table 
tools: Layout tab is 
active 

2 Click on Insert Left  in 

the Rows & Columns 
group to insert a new 
column to the left of the 
Country column 

3 Click on Model, then 
click on Insert Right  

in the Rows & Columns 
group to insert a new 
column to the right of the 
Model column 

4 Enter the details, as 
shown, into the new 
columns 

Let’s create a new row... 

5 Click on ELEC00001, 
then click on Insert 
Below  in the Rows & 

Columns group to insert 
a new row below the cell 
containing ELEC00001 

6 Enter the details in the 
new row, as shown 
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DELETING COLUMNS AND ROWS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To delete a row or column: 
1. Click on the desired table cell, then 

activate the Table Tools: Layout tab 
2. From the Rows & Columns group, 

click on Delete  and select Delete 

Rows to delete a row, or select Delete 

Columns to delete a column 

Handy to Know… 

 You can also use Delete  in the 

Rows & Columns group to delete a 

selected cell or the entire table. 

1 

2 

Occasionally you will find that you need to 
delete columns or rows from your table − 
perhaps circumstances have changed and 
you no longer need the information. In 

Word, it is almost as easy to delete 

columns and rows from a table as it is to 
insert them. But just as a note, if the 
columns or rows to be deleted contain data, 
this data will be deleted along with the 

columns or rows. 

4 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W819 Creating 
Tables_4.docx.... 

 The AGE Marketing 
Department has decided 
to remove the Country 
from the catalogue... 

1 Click on Country, then 
ensure that the Table 
Tools: Layout tab is 
active 

2 Click on Delete  in the 

Rows & Columns group, 
then select Delete 

Columns 

The column and its 
contents will be deleted – 
no questions asked. 

The Electric Document is 
no longer being produced 

so we must remove this 
from the catalogue as 
well... 

3 Click on Electric 
Document 

4 Click on Delete  in the 

Rows & Columns group, 

then select Delete Rows 

The row and its contents 
will be deleted and the 
rows below will move up 
to take its place 
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CHANGING COLUMN WIDTHS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W819 Creating 
Tables_5.docx... 

1 Select the Catalogue 
No column, then 
ensure that the Table 
Tools: Layout tab is 
active 

Currently the column 
is  
3.53 cm, as shown in 
Table Column Width in 
the Cell Size group... 

2 Click on the down 

spinner arrow  for 
Table Column Width 
in the Cell Size group 
until the column’s 
width reduces to 2.7 
cm 

3 Repeat steps 1 and 2 

to alter the widths of 
the remaining columns 
to the following 

Model 4 cm 
Category 3.8 cm 
Plant 3.2 cm 

 

For Your Reference… 

To change a column’s width: 
1. Select the desired table column, then 

activate the Table Tools: Layout tab 
2. Click on the up or down spinner arrow 

for Table Column Width in the Cell 

Size group 

Handy to Know… 

 You can also change the width of 
adjacent columns using the mouse. To 
do this, hover over the border between 
the columns until the pointer appears 
as a pair of vertical lines with a double-
headed arrow , then drag left or 

right as desired. 

2 

3 

Once you start entering data into a table 
you may find that some columns are not 
wide enough for the data while others are 
too wide. So to make the best use of 

available space and to make the table look 

as neat as possible, you may need to 
change column widths. This is easy to do 
using the Table Column Width tool on the 
ribbon. 
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CHANGING ROW HEIGHTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To change a row’s height: 
1. Select the desired table row, then 

activate the Table Tools: Layout tab 
2. Click on the up or down spinner arrow 

for Table Row Height in the Cell 

Size group 

Handy to Know… 

 If you have specified different heights 
for different rows, a quick way to 
ensure that they all have the same 
height is to select them and click on 
Distribute Rows  in the Cell Size 

group.  

2 

3 

If you create a table on a new, blank 
document the text in the cells will appear 
with very little ‘white space’ above and 
below it. By default, the text is aligned to 

the top left corner of the cells so if you 

increase the row heights, you will increase 
the white space below the text. To even out 
this white space and ensure the table is 
aesthetically pleasing, you simply alter the 

cell alignment. 

5 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or open 

the file W819 Creating 
Tables_6.docx... 


Select the Catalogue No 
row, then ensure that the 
Table Tools: Layout tab is 
active 

Currently the row is  

0.48 cm high, as shown in 
Table Row Height in the Cell 
Size group... 


Click on the up spinner arrow 

 for Table Row Height in 
the Cell Size group until the 
row’s height increases to  

0.7 cm 

Let’s adjust the cell alignment 
to centre the text vertically 
within the cells... 


Click on Align Centre Left 

 in the Alignment group 


Select the TEL00001 row, 
then hold down the mouse 
button and drag down until 
the remaining five rows are 
selected 


Repeat steps 2 and 3 to 
increase the height of the 

remaining rows to 0.5 cm 
and then centre the text 
vertically within the rows 
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AUTOFITTING COLUMNS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To autofit columns: 

1. Select the table, then click on AutoFit 
 

2. Select AutoFit Contents to reduce the 
column widths to fit the content, or 

Select Fixed Column Width to fix the 
column width, or 

Select AutoFit Window 

Handy to Know… 

 If a table is set to AutoFit Window 
and you insert a new column, the size 
of the existing columns in the table will 
reduce so that the final table width 
(with the new column) still fits the 

window.  

1 

4 

By default, when you create a table using 
the Insert Table command, it will 
automatically fit the window and the 
column widths will be equal but not fixed – 

that is, their widths will change if you add 

or delete columns. Using the Autofitting 
features you can change a table so that the 
column widths remain fixed, or you can 
reduce all column widths so that they just fit 

their largest entry. 

5 

Try This Yourself: 

S
a
m

e
 

F
il

e
 

Continue using the previous 
file with this exercise, or open 

the file W819 Creating 
Tables_7.docx... 

1 Select the entire table, then 
ensure that the Table Tools: 
Layout tab is active 

2 Click on AutoFit  in the Cell 

Size group and select AutoFit 
Contents  

The width of the columns will 
automatically reduce to fit... 

3 Click on AutoFit  in the Cell 

Size group and select Fixed 
Column Width 

Nothing will appear to have 
happened. But let’s see what 
happens when you insert a 
new column... 

4 Select the Plant column and 
insert a column to the right 

The Table width will increase 
by the width of the new 
column (whose width will be 
identical to the Plant column)... 

5 Select the table again, then 
click on AutoFit  in the Cell 

Size group and select AutoFit 
Window  

The width of each column will 
increase so that the table will 
be as wide as the window 
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SHADING CELLS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 

the file W819 Creating 
Tables_8.docx... 

1 Select the heading row 
of the table, then click 
on the Table Tools: 
Design tab on the 
ribbon 

2 Click on the drop arrow 
for Shading  in the 

Table Styles group 

A gallery of available 
colours will appear... 

3 Click on Dark Blue, 
Text 2, Lighter 40% 
(4th row, 4th column) to 
apply the colour to the 
row 

4 Click outside the table 
so you can see the 
shading more clearly 

 

For Your Reference… 

To apply shading to cells: 
1. Select the table cells 
2. Click on the drop arrow for Shading 

 

3. Click on the desired colour 

Handy to Know… 

 The shading gallery includes numerous 
shades of the selected theme colours 
plus ten standard colours. If you want 
to choose a different colour, click on 
More Colours, drag the marker 

around the larger Colours box plus the 
vertical colour ramp as desired, and 

then click on [OK]. 

2 

4 

Word allows you to apply shading to 
selected cells in a table. For instance, you 
may want to highlight cells containing 
important information. The shading can be 

any colour supported by your computer and 
Word. You apply shading to cells via the 
Shading tool on the Table Tools: Design 
tab on the ribbon. 
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MODIFYING BORDERS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To modify borders: 
1. Select the table 
2. Click on the drop arrow for Borders 

 and select Borders and Shading 

3. Change the settings as desired 
4. Click on [OK] 

Handy to Know… 

 If you had just wanted to change the 
border weight for the table, you could 
have selected the cells, selected the 
desired Line Weight in the Draw 
Borders group, and then selected the 

appropriate Borders menu option 
(such as Outside Borders) in the 

Table Styles group. 

2 

3 

When you insert a table in Word, it 
appears with a border by default. This 
gives a matrix-like appearance to the 
table. You can change any or all of the 

lines in a table to suit your own tastes and 

to add more visual effects and appeal to the 
table. For example, you could place a thicker 
line around the outside of the table and a 
thinner line below the heading row. 

6 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W819 Creating 
Tables_9.docx... 

1 Select the entire table, 
then ensure that the 
Table Tools: Design 
tab is active 

2 Click on the drop 
arrow for Borders  

in the Table Styles 
group, then select 
Borders and 
Shading to open the 
Borders and 

Shading dialog box 

3 Click on Box under 
Setting 

All internal lines will 
disappear from the 
Preview pane... 

4 Click on the drop 

arrow for Colour and 
select Dark Blue, 
Text 2 (1st row, 4th 
column) 

5 Click on the drop 
arrow for Width and 
select  

1 ½ pt 

6 Click on [OK] to apply 
the changes, then click 
outside the table to 
see the changes 
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MODIFYING BORDER STYLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 

To modify border styles: 
1. Select the table 
2. Click on the drop arrow for Borders 

 and select Borders and Shading 

3. Change the Style as desired 
4. Click on [OK] 

Handy to Know… 

 You can also change border styles for 
specific cells in the table. To do this, 
select the desired cells before altering 
the settings in the Borders and 

Shading dialog box. 

3 

4 

By default, when you display borders on a 
table they appear as single black lines. You 
can alter the style used ranging from a 
single line to a dotted, dashed, double, 

triple, or even wavy line. You can modify 
border styles using the Borders and 
Shading dialog box. 

5 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the file 
W819 Creating 
Tables_10.docx... 

1 Select the table, then 
ensure that the Table 
Tools: Design tab is 
active 

2 Click on the drop arrow 
for Borders  in the 

Table Styles group, then 
select Borders and 
Shading to open the 
Borders and Shading 
dialog box 

3 Scroll half way down the 
Style box and click on 
the style as shown – the 
new line style will appear 
in Width 

Now you need to apply 
the new border style to 
the table and you do this 
in the Preview pane... 

4 Click on each of the four 
borders that currently 
appear under Preview 

Notice that the new 
border style replaces the 

single border line style... 

5 Click on [OK] to apply 
the changes, then click 
outside the table to view 
the changes 
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CHOOSING A TABLE STYLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
m

e
 F

il
e
 Continue using the 

previous file with this 
exercise, or open the 
file W819 Creating 
Tables_11.docx... 

1 Click in the table, 
then ensure that the 
Table Tools: Design 
tab is active 

2 Click on the More 
button  for Table 
Styles to open the 
table styles gallery 

3 Roll over several 
options to see a live 
visual preview of the 

table using different 
table styles 

4 Click on Light List – 
Accent 1 (this is a 
medium blue style 
located near the top 
of the gallery) 

5 Click outside the 
table to deselect it 
and view the change 

 

For Your Reference… 

To apply a table style: 
1. Click in the table 
2. Click on the More button  for Table 

Styles 

3. Select the desired style 

Handy to Know… 

 After you have applied a table style to 
a table, you can modify it as desired. 
To do this, click on the More button  
for Table Styles and select Modify 
Table Style. From the Modify Styles 

dialog box you can change all features 
including font, banding, paragraph 

spacing, borders, plus more.  

4 

5 

Table styles provide you with a series of 
stylistic templates that can be applied to a 
table. These styles control the type and 
nature of the borders, colours, shading, 

banding, style of text, alignment, 

paragraph spacing, and the like. There are 
many styles from which you can choose and 
you can even customise the existing settings 
of a style to suit your own tastes. 
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CONCLUDING REMARKS 
 

  

Congratulations!  

You have now completed the Tables booklet.  This booklet was designed to get you to the 
point where you can competently perform a variety of operations as listed in the objectives 
on page 2.  

We have tried to build up your skills and knowledge by having you work through specific 
tasks. The step by step approach will serve as a reference for you when you need to repeat 
a task. 

 

Where To From Here… 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills 
that you have acquired and use some of the application's commands. This will test 
just how much of the concepts and features have stuck! Don't try a big task just yet if 
you can avoid it - small is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points 
that you may be unclear about. Use the examples and exercises in these notes and 
have another go - these step-by-step notes were designed to help you in the 
classroom and in the work place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 visit CLD’s e-learning zone on the Intranet  

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities, browse the Internet, specifically the technical 
pages of the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we 
don't suggest that you plagiarise but you can certainly learn from the techniques of 
others 

 if your software came with a manual (which is rare nowadays) spend a bit of time 
each day reading a few pages. Then try the techniques out straight away - over a 
period of time you'll learn a lot this way 

 and of course, there are also more courses and booklets for you to work through 

 finally, don’t forget to contact CLD’s IT Training Helpdesk on 01243-752100 
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